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SAFETY PRECAUTIONS
(Always read these precautions before using this product.)
Before using this product, read this manual and the relevant manuals introduced in this manual carefully and pay full attention 
to safety to handle the product properly.
The precautions given in this manual are concerned with this product.
In this manual, the safety precautions are ranked as " WARNING" and " CAUTION".

Note that failure to observe the CAUTION level instructions may also lead to serious results depending on the 
circumstances.
Make sure to follow the instructions of both levels to ensure personal safety.
Save this manual to make it accessible when required and always forward it to the end user.

[Test Operation Precautions]

WARNING
● Thoroughly read the manual to fully understand the operating procedures before testing the operation 

of a user-created monitor screen (such as turning on or off a bit device, changing the current value of 
a word device, changing the set value or current value of a timer or counter, and changing the current 
value of a buffer memory).
During the test operation, never change the data of the devices which are used to perform significant 
operation for the system.
Doing so may cause an accident due to a false output or malfunction.

WARNING

CAUTION

Indicates that incorrect handling may cause hazardous conditions, 
resulting in death or severe injury.

Indicates that incorrect handling may cause hazardous conditions, 
resulting in minor or moderate injury or property damage.
1
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PRECAUTIONS FOR USE

Memory capacity of a personal computer
Depending on the model of the personal computer, the processing may be ended by Windows when the memory capacity is 
less than 512 MB.
Use MELSOFT GT OPC UA Client with a memory capacity 512 MB or more.

Hard disk (virtual memory) space
During the execution of MELSOFT GT OPC UA Client, 100 MB or more free space in the hard disk (virtual memory) is 
necessary.
When 100 MB or more free space in the hard disk is not available during the execution of MELSOFT GT OPC UA Client, the 
processing may be ended by Windows.
Make sure to have enough free space in the hard disk (virtual memory), and use MELSOFT GT OPC UA Client.
When the free space in the virtual memory is small, save the project frequently.

Error massage displayed at this software startup or during data editing
MELSOFT GT OPC UA Client checks the free space in the memory at the following operation.
 • At startup
 • At tag information acquisition
 • At tag information save
When the free space in the virtual memory is 100 MB or less, the following message is displayed.
[Operation will be terminated because of insufficient memory. Would you like to stop?] 
Click [Yes] to stop the operation with MELSOFT GT OPC UA Client displayed.
Click [No] to continue the operation.
In this case, exit some running application software or restart Windows to free up memory space.

Screen setting of Windows
Do not change the default font size in the screen setting of Windows. If the default font size is changed, the dialogs or others 
appear improperly.
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RELEVANT MANUAL
The following lists the manuals relevant to this product.
If you need the printed manuals, consult your local sales office.

Manual list
■ Screen design software-related manuals

■ GT SoftGOT2000 manuals

e-Manual
e-Manual refers to the Mitsubishi Electric FA electronic book manuals that can be browsed using a dedicated 
tool.
e-Manual has the following features:
 • Required information can be cross-searched in multiple manuals.
 • Other manuals can be accessed from the links in the manual.
 • Hardware specifications of each part can be found from the product figures.
 • Pages that users often browse can be bookmarked.

Manual name Manual number
(Model code)

Format

GT Designer3 (GOT2000) Screen Design Manual SH-081220ENG
(1D7ML9)

PDF
e-Manual

Manual name Manual number Format
GT SoftGOT2000 Version1 Operating Manual SH-081201ENG PDF

e-Manual
5
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ABBREVIATION AND GENERIC TERM
The following shows the abbreviations and generic terms used in this manual.

Software
■ Software related to GOT

TERM LIST
The following terms are used in this manual unless they are stated in other sections.

Abbreviations and generic terms Description
GT Designer3 Screen design software for GOT2000 series included in GT Works3

GT OPC UA Client MELSOFT GT OPC UA Client (SW1DNN-GTOUC-MD)

GT SoftGOT2000 A GOT2000 compatible HMI software GT SoftGOT2000

Term Description
OPC Generic term for OLE for Process Control.

An interoperability standard for the secure and reliable exchange of data in the 
industrial automation space and in other industries.

OPC UA Generic term for OPC Unified Architecture.
A platform independent service-oriented architecture that integrates all the 
functionality of the individual OPC Classic specifications into one extensible 
framework.

OPC UA tag The information to access the device data of CPU module on the host CPU 
module and network, from OPC UA client.

Tag information The information such as name, configuration, and data format of the OPC UA 
tag.

End point The server and client connected to the end of network.
Physically, it indicates the end personal computer and OPC UA server unit.

Server certificate An electronic certificate for proofing the authenticity of the server with SSL 
authentication.
It is used for encryption of the transmit data and mutual authentication 
between the client and server, at the communication between GT OPC UA 
Client and the OPC UA server.

Client certificate An electronic certificate for proofing the authenticity of the client with SSL 
authentication.
It is used for encryption of the transmit data and mutual authentication 
between the client and server, at the communication between GT OPC UA 
Client and the OPC UA server.
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1 INTRODUCTION
Thank you for downloading MELSOFT GT OPC UA Client.
This manual explains the overview, specifications, installation procedure, uninstallation procedure, and basic usage of 
MELSOFT GT OPC UA Client (hereafter referred to as GT OPC UA Client).
Before using the product, read this document thoroughly and fully understand the functions and performance of GT OPC UA 
Client for correct use.

To obtain the latest version of GT OPC UA Client, contact your local sales office.

1.1 Features
GT OPC UA Client has the following features.

Connection setting for the OPC UA server
The settings for the connection between the personal computer and OPC UA server can be configured in GT OPC UA Client.
In the following cases, the end point URL can be acquired automatically by searching the OPC UA server.
 • When the personal computer where GT OPC UA Client is installed and the OPC UA server are on the same subnet
 • When GT OPC UA Client and the OPC UA server are installed on the same personal computer

Personal computer

GT OPC UA Client

OPC UA server

Ethernet (same subnet)

Search for the OPC UA server

Acquire the end point URL 
of the OPC UA server
1  INTRODUCTION
1.1  Features 7
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Tag information batch read
With GT OPC UA Client, the tag information can be collectively obtained from an OPC UA server and exported to a tag 
information file.
By importing the tag information file to GT Designer3, the OPC UA tag can be set as the monitor device of GT SoftGOT2000.

OPC UA library
An OPC UA library that is necessary for connecting GT SoftGOT2000 with the OPC UA server is included in GT OPC UA 
Client.
To connect GT SoftGOT2000 with the OPC UA server, GT OPC UA Client is required to be installed to the personal computer 
where GT SoftGOT2000 is installed.
By connecting GT SoftGOT2000 with the OPC UA server, the data collected by the OPC UA server can be read, and the data 
can be written via the OPC UA server.

Personal computer

GT Designer3GT OPC UA Client

OPC UA server

Acquire 
the tag 

information

Acquire the tag 
information

Export Import

Address Space

Dev00

Group000

Str000

Dev01

OPC UA tag
• Tag000

• Tag001

• Tag002

Tag information

Device setting

Personal computer

GT SoftGOT2000

OPC UA serverControllers compatible with OPC UA

Read device values 
to the OPC UA tag

Write the OPC UA tag 
values to the device

GT OPC UA Client

OPC UA 
library Refer to for connecting 

with OPC UA server

Read values from the OPC UA tag

Write values to the OPC UA tag

• Tag000
• Tag001
• Tag002

OPC UA tag
• R0D00
• R0D01
• R0D02

Device
1  INTRODUCTION
1.1  Features
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2 SPECIFICATIONS
This chapter describes the specifications of GT OPC UA Client.

2.1 Operating Environment
The following shows the operating environment for GT OPC UA Client.

*1 For installation, administrator privileges are required.
For startup, the standard user or administrator account is required.
To use GT OPC UA Client with another application that runs with administrator privileges, run GT OPC UA Client with administrator 
privileges.

*2 The following functions are not supported.
Application start in Windows compatibility mode
Fast user switching
Change your desktop themes (fonts)
Remote desktop
Setting the size of text and illustrations on the screen to any size other than [Small-100%]

*3 Windows XP Mode is not supported.
*4 For the touch function, the tap operation and holding are supported.
*5 Modern UI Style is not supported.
*6 Hyper-V is not supported.
*7 Tablet mode is not supported.
*8 Unified Write Filter is not supported.
*9 For Windows 8 or later, change [Current Default] for [.pdf] from [Reader] to [Adobe Reader] using the control panel.

Item Description
Model Windows-compatible personal computer

OS (English version) • Microsoft Windows 10 Enterprise (32 bit, 64 bit) *1*2*6*7*8

• Microsoft Windows 10 Pro (32 bit, 64 bit) *1*2*6*7*8

• Microsoft Windows 10 Home (32 bit, 64 bit) *1*2*6*7*8

• Microsoft Windows 10 IoT Enterprise 2016 LTSB (64 bit) (English OPK, or English OPK and a language pack for 
localization) *1*2*6*7*8

• Microsoft Windows 8.1 Enterprise (32 bit, 64 bit) *1*2*4*5*6

• Microsoft Windows 8.1 Pro (32 bit, 64 bit) *1*2*4*5*6

• Microsoft Windows 8.1 (32 bit, 64 bit) *1*2*4*5*6

• Microsoft Windows 8 Enterprise (32 bit, 64 bit) *1*2*4*5*6

• Microsoft Windows 8 Pro (32 bit, 64 bit) *1*2*4*5*6

• Microsoft Windows 8 (32 bit, 64 bit) *1*2*4*5*6

• Microsoft Windows 7 Enterprise (32 bit, 64 bit) Service Pack1 or later *1*2*3

• Microsoft Windows 7 Ultimate (32 bit, 64 bit) Service Pack1 or later *1*2*3

• Microsoft Windows 7 Professional (32 bit, 64 bit) Service Pack1 or later *1*2*3

• Microsoft Windows 7 Home Premium (32 bit, 64 bit) Service Pack1 or later *1*2*3

• Microsoft Windows 7 Starter (32 bit) Service Pack1 or later *1*2*3

CPU Intel Core 2 Duo Processor 2.0 GHz or more recommended

Memory • For a 64-bit OS: 2 GB or more recommended
• For a 32-bit OS: 1 GB or more recommended

Display Resolution: XGA (1024 × 768 dots) or higher

Hard disk space • For installation: 5 GB or more recommended
• For execution: 512 MB or more recommended

Display color High Color (16 bits) or higher

Other software applications To display PDF manuals, the following software application must be installed.
• Adobe Reader7 or later recommended *9

Other hardware devices Use the hardware compatible with the above OS.
• For installation: Mouse, keyboard, and DVD-ROM drive
• For execution: Mouse and keyboard
2  SPECIFICATIONS
2.1  Operating Environment 9
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2.2 System Configuration
The following shows the system configuration of GT OPC UA Client.

OPC UA server

• Tag000
• Tag001

OPC UA tag

• Tag000
• Tag001

OPC UA tag

Personal computer

Tag information 
file

Import

GT Designer3

Ethernet

OPC UA server Personal computer

Controllers compatible with OPC UA

Ethernet

Personal computer

GT SoftGOT2000 
(client)

GT OPC UA Client

OPC UA 
library Refer to for connecting 

with OPC UA server

Personal computer

GT Designer3

GT OPC UA Client 
(client)

Tag information 
file

Export

Import

Acquire the tag 
information

GT OPC UA Client 
(client)

Tag information 
file

Export

Copy

Acquire the tag 
information

Read/write values 
from/to the OPC UA tag

Read/write values 
from/to the OPC UA tag

Personal computer

GT SoftGOT2000 
(client)

GT OPC UA Client

OPC UA 
library

Read/write values 
from/to the OPC UA tag

Refer to for connecting 
with OPC UA server

Read/write values 
from/to the OPC UA tag
2  SPECIFICATIONS
2.2  System Configuration
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2.3 Required Software
The following shows the software required for using GT OPC UA Client.

2.4 OPC UA Server
The number of clients that can be connected differs depending on the specification of the OPC UA server.
The client includes GT OPC UA Client and GT SoftGOT2000.
The following shows the OPC UA server that can be accessed by GT OPC UA Client.

Specifications

Recommended server
For the recommended OPC UA servers, refer to the following Technical Bulletin.
List of Valid Devices Applicable for GOT2000 Series OPC UA Server Connection(GOT-A-0137)
For Technical Bulletin, refer to MITSUBISHI ELECTRIC FA Global Website.
us.mitsubishielectric.com/fa/en/

2.5 Tag Information
The configuration of the tag information differs depending on the OPC UA server to be used.
For the details of tag information, refer to the following.
Manual of the OPC UA server used
For the tag information file that can be imported with GT Designer3 and the details of OPC UA tag, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Software Version
GT Designer3 Version 1.215Z or later

GT SoftGOT2000

Item Specifications
Version OPC UA 1.03 or later

Required service set The following OPC UA service sets are required.
• Discovery service set
• SecureChannel service set
• Session service set
• View service set
• Attribute service set
2  SPECIFICATIONS
2.3  Required Software 11



12
3 INSTALLATION AND UNINSTALLATION
This chapter explains the installation and uninstallation of GT OPC UA Client.

3.1 Installation

Precautions before installation
■ Authority of login user
Log in to the personal computer with the administrator account.
If you log in with the account other than administrators, GT OPC UA Client cannot be installed.

■ Exiting the software
Before the installation, exit all the software running on the OS.
If the product is installed while other software is running, it may not operate properly.

■ Prohibiting the update program
Install the product after changing the setting to disable the automatic startup of the update program in Windows.
When the update program is automatically started during the installation, the installer may not operate properly.

■ Canceling the compatibility mode
Cancel the compatibility mode of Windows if it is enabled.
If it is not canceled, the installation of GT OPC UA Client fails.

■ Unavailable characters and character strings
The following characters and character strings cannot be used for specifying the install destination folder.
 • / * < > | : ;
 • Reserved words of Windows (COM0 to COM9, LPT0 to LPT9, AUX, CON, PRN, NUL, CLOCK$)

■ Folders that cannot be specified as install destination folder
[Documents] cannot be specified as the install destination folder.

■ Executing Windows Update
Execute Windows Update in advance and update the personal computer to the latest version.
If the personal computer is not the latest version, the installation may fail.

Procedure
The following shows the procedure of installing GT OPC UA Client to the personal computer.

1. Decompress the file downloaded from MITSUBISHI ELECTRIC FA Global Website and start setup.exe.

2. When the setup starts, follow the on-screen instructions to install.

3. When the installation is completed, click the [Finish] button to exit the installer.
If Windows needs to be restarted, restart Windows after clicking the [Finish] button.
3  INSTALLATION AND UNINSTALLATION
3.1  Installation
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3.2 Uninstallation

Precautions before uninstallation
■ Exiting the software
While GT SoftGOT2000 or GT OPC UA Client is being used, GT OPC UA Client cannot be uninstalled.
Exit the software before the uninstallation.

Procedure
The following shows the procedure of uninstalling GT OPC UA Client from the personal computer.

1. Select [GT OPC UA Client Setting Tool] from [Programs and Features] in [Control Panel], and select [Uninstall] with right-
click context menu.

2. Follow the on-screen instructions to uninstall.

3. Click the [Finish] button to end the uninstallation.
3  INSTALLATION AND UNINSTALLATION
3.2  Uninstallation 13
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4 OPERATING PROCEDURE
The following shows the outline procedure from acquiring the tag information from the OPC UA server to exporting to the tag 
information file.

1. Start GT OPC UA Client.
Page 15 Starting GT OPC UA Client

2. Connect GT OPC UA Client with the OPC UA server.
Page 16 Connecting with the OPC UA Server

3. Authenticate the certificate mutually as a trusted certificate in GT OPC UA Client and the OPC UA server as necessary.
Page 21 Authenticating the server certificate in GT OPC UA Client

Page 21 Authenticating the client certificate in OPC UA server

4. Acquire the tag information from the OPC UA server.
Page 24 Acquiring the tag information

5. Export the acquired tag information to the tag information file.
Page 25 Exporting the tag information
4  OPERATING PROCEDURE
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6. Import the exported tag information file to GT Designer3.
For the details of the importing method, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual
When starting GT OPC UA Client associating with GT Designer3 and acquiring the tag information from the OPC UA server, 
refer to the following.
Page 26 STARTING ASSOCIATING WITH GT Designer3

4.1 Starting and Exiting the Application
The following shows the starting procedure and exiting procedure of GT OPC UA Client.

Starting GT OPC UA Client
Select [Start] → [MELSOFT] → [GT OPC UA Client Setting Tool] to start GT OPC UA Client.
To switch the display language, refer to the following.
Page 30 SWITCHING DISPLAY LANGUAGE

Exiting GT OPC UA Client
Perform one of the following operations to exit GT OPC UA Client.
 • Select [Project] → [Exit] in the main window.
 • Click the [×] button in the title bar.
4  OPERATING PROCEDURE
4.1  Starting and Exiting the Application 15
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4.2 Connecting with the OPC UA Server
This section explains the connection of GT OPC UA Client and the OPC UA server.

Connecting GT OPC UA Client with the OPC UA server
The following shows the procedure for connection.

1. In the main window, select [Project] → [Access destination device setting] from the menu to display the [Access 
destination device setting] dialog.

Page 17 [Access destination device setting] dialog

2. Set the following items.
 • [End point URL]
 • [Security Policy]
 • [Security Mode]
 • [Timeout Time]

3. Click the [Check] button to send the connection request from GT OPC UA Client to the OPC UA server.
When the settings are correct, and the trusted server certificate and client certificate exist, the server name acquired from the 
OPC UA server to be connected is displayed in [Server Name].
To authenticate the server certificate, or to create the client certificate, refer to the following.
Page 21 Authenticating the server certificate in GT OPC UA Client
Page 21 Authenticating the client certificate in OPC UA server

4. Set [User token type].

5. Click the [OK] button to establish the connection between GT OPC UA Client and the OPC UA server.

3. 

2.

4.

5.
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[Access destination device setting] dialog
The following shows the setting items of the [Access destination device setting] dialog.

The access destination device setting can be saved to the setting file (*.gtpm).
The saved setting file (*.gtpm) can be read from GT OPC UA Client in other personal computers.
For the saving method and reading method of the setting file (*.gtpm), refer to the following.
Page 19 Saving the access destination device setting to a file
Page 19 Opening the access destination device setting from the file

No. Item Description
1) [End point URL] Set the end point URL of the OPC UA server to be connected.

When the URL is entered directly, up to 1024 characters can be entered.
Click the [Search] button to search the OPC UA server on the same host or subnet and set the 
end point URL. *1

Page 18 [Search] dialog

2) [Server Name] The server name of the OPC UA server to be connected is displayed.

3) [Security Policy] Select the encryption method used in the communication.
Set this item according to the setting of the OPC UA server to be connected.
• [None]

No encryption.
• [Basic128Rsa15]

128-bit encryption is used.
• [Basic256]

256-bit encryption is used.
• [Basic256Sha256]

256-bit encryption is used with a signature added.

4) [Security Mode] Set whether to add a signature and encrypt the communication data.
Set this item according to the setting of the OPC UA server to be connected.
• [None]

No encryption.
• [Sign]

Add a signature.
• [SignAndEncrypt]

Add a signature and encrypt.

5) [Timeout Time] Set the time period for server connection to time out.
The setting range is [1] second to [30] seconds.

1)

2)
3)
4)
5) 6)

7)

9)
8)
4  OPERATING PROCEDURE
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*1 Depending on the type of the OPC UA server, it may not be searched by the [Search] dialog.

■ [Search] dialog

6) [Check] button Check the settings of [Setting of connection end server], and the existence of the trusted 
server certificate and client certificate.
• When the settings are correct and the trusted server certificate and client certificate exist, 

the server name acquired from the OPC UA server to be connected is displayed in [Server 
Name].

• When the trusted server certificate does not exist, the [Authentication of server certificate] 
dialog is displayed.

Page 19 [Authentication of server certificate] dialog
After the server certificate is authenticated, click the [Check] button again to display the server 
name acquired from the OPC UA server to be connected in [Server Name].
• When the client certificate does not exist, the [Creation of client certificate] dialog is 

displayed.
Page 22 [Creation of client certificate] dialog
After the client certificate is created, click the [Check] button again to display the server name 
acquired from the OPC UA server to be connected is displayed in [Server Name].

7) [User token type] Set the user authentication method.
• [Anonymous user]

Log in as an anonymous user.
• [User name/Password]

Authenticate the user with the user name and password.
Select this item, and set [User Name] and [Password].

8) [OK] button Connect GT OPC UA Client with the OPC UA server and close the [Access destination device 
setting] dialog.

9) [Cancel] button Discard the setting and close the [Access destination device setting] dialog.

No. Item Description
1) [Host] Enter the keyword of the host name and click the [Search] button to display the search result in 

the end point URL list.

2) End point URL list The end point URL of the searched OPC UA server is displayed in a list.
Select the end point URL of the OPC UA server to be connected from the list.

3) [OK] button Apply the selected end point URL to the [Access destination device setting] dialog and close 
the [Search] dialog.

4) [Cancel] button Close the [Search] dialog.

No. Item Description

2)

1)

4)
3)
4  OPERATING PROCEDURE
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■ [Authentication of server certificate] dialog

Saving the access destination device setting to a file
The access destination device setting can be saved to the setting file (*.gtpm).
The saved setting file (*.gtpm) can be read from GT OPC UA Client in other personal computers.
The following shows the procedure to save the setting file (*.gtpm).

1. In the main window, select [Project] → [Save as Access destination device setting] from the menu to display the [Save as 
Access destination device setting] dialog.

2. Set the save destination, file type, and file name, and click the [Save] button to export the settings to a setting file 
(*.gtpm).

Opening the access destination device setting from the file
The access destination device setting can be read from the setting file (*.gtpm).
The following shows the procedure to read the access destination device setting from the setting file (*.gtpm).

1. In the main window, select [Project] → [Open Access destination device setting] from the menu to display the [Open 
Access destination device setting] dialog.

2. Set the save destination, file type, and file name, and click the [Open] button to open the access destination device 
setting.

3. Connect GT OPC UA Client and the OPC UA server in the [Access destination device setting] dialog.
Page 17 [Access destination device setting] dialog

No. Item Description
1) [Field] The item name of the server certificate is displayed.

2) [Value] The value acquired from the server certificate is displayed.

3) [OK] button Close the [Authentication of server certificate] dialog after the server certificate is 
authenticated as a trusted certificate.

4) [Cancel] button Close the [Authentication of server certificate] dialog without authenticating the server 
certificate.

2)

4)
3)

1)
4  OPERATING PROCEDURE
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4.3 Mutual Authentication of Client Certificate and 
Server Certificate

This section describes how to mutually authenticate the client certificate and server certificate as a trusted certificate in GT 
OPC UA Client and the OPC UA server.

Overview of client certificate and server certificate
The client certificate and server certificate are electronic certificates used to check the authenticity in GT OPC UA Client and 
OPC UA server mutually, and to encrypt the data.
To connect GT OPC UA Client and the OPC UA server, the certificate is required to be trusted mutually in GT OPC UA Client 
and the OPC UA server.

1. In the [Access destination device setting] dialog of GT OPC UA Client, click the [Check] button to send the connection 
request to the OPC UA server to be connected.

Page 17 [Access destination device setting] dialog

2. The OPC UA server sends the server certificate to GT OPC UA Client, and requests for presenting a client certificate.

3. GT OPC UA Client compares the received server certificate and the certificate stored in advance to check the 
authenticity.

4. GT OPC UA Client sends the client certificate to the OPC UA server.

5. The OPC UA server compares the received client certificate and the certificate stored in advance to check the 
authenticity.

6. The connection between GT OPC UA Client and the OPC UA server is established.

Check the authenticity

Trusted server 
certificate

Received 
server certificate

3.

GT OPC UA Client OPC UA server
Connection established

Request for 
connection

1.

6.

Present the server certificate and 
request for presenting the client 
certificate

2.

Present the client 
certificate

4. Check the authenticity

Trusted 
client certificate

Received 
client certificate

5.
Client certificate

Server certificate
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Authenticating the server certificate in GT OPC UA Client
The server certificate can be acquired and authenticated in the [Access destination device access] dialog at the setting of the 
access destination device.
Page 17 [Access destination device setting] dialog
When the trusted service certificate does not exist in GT OPC UA Client, authenticate the server certificate as a trusted 
certificate with the following procedure.

1. Click the [Check] button in the [Access destination device setting] dialog to display the [Authentication of server 
certificate] dialog.

Page 19 [Authentication of server certificate] dialog

2. Click the [OK] button in the [Authentication of server certificate] dialog to authenticate the server certificate.

Authenticating the client certificate in OPC UA server
The authentication type differs depending on the OPC UA server to be connected.

With an OPC UA server supporting automatic authentication of a client certificate
The client certificate is authenticated when the connection request is sent in the [Access destination device setting] dialog.
Page 17 [Access destination device setting] dialog

■ When a valid client certificate exists in GT OPC UA Client
Click the [Check] button in the [Access destination device setting] dialog so that the client certificate is automatically 
authenticated as a trusted certificate in the OPC UA server side.

■ When a valid client certificate does not exist in GT OPC UA Client
1. Click the [Check] button in the [Access destination device setting] dialog to display the [Creation of client certificate] 

dialog.
Refer to the following and create the client certificate.
Page 22 [Creation of client certificate] dialog

2. Click the [Check] button again in the [Access destination device setting] dialog so that the client certificate is 
automatically authenticated as a trusted certificate in the OPC UA server side.

With an OPC UA server not supporting automatic authentication of a client certificate
Before the connection, the client certificate is required to be copied to the OPC UA server and authenticated as a trusted 
certificate in the OPC UA server.
The following shows the procedure to authenticate the client certificate in the OPC UA server to be connected.

1. Create the client certificate with GT OPC UA Client.
Page 22 Creating the client certificate

2. Export the client certificate.
Page 23 Exporting the client certificate

3. Copy the client certificate to the OPC UA server and authenticate it as a trusted certificate.
How to authenticate the client certificate manually differs depending on the OPC UA server.
For the details of the authentication type, refer to the following.
 Manual of the OPC UA server to be connected
4  OPERATING PROCEDURE
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Creating the client certificate
Create the client certificate when a valid client certificate does not exist in GT OPC UA Client.
The client certificate is not necessary to be created every time GT OPC UA Client is connected with the OPC UA server.
The following shows the procedure to create the client certificate.

1. In the main window, select [Client Certificate] → [Create] from the menu to display the [Creation of client certificate] 
dialog.

2. Enter each item of the client certificate.
[Organization name], [Domain], [Strength of RSA key], and [Signature algorithm] are required to be set.
If these are not set, the client certificate cannot be created.

3. Click the [OK] button to create the client certificate and security key in the following folders.
Client certificate: C:\Users\(User name)\AppData\Roaming\MELSOFT GT OPC UA Client Setting Tool\PKI\certs
Security key: C:\Users\(User name)\AppData\Roaming\MELSOFT GT OPC UA Client Setting Tool\PKI\private

[Creation of client certificate] dialog

No. Item Description
1) [Organization name] Set the organization name within 256 characters.

This item is required to be set.

2) [Unit of organization] Set the unit of organization within 256 characters.

3) [Region name] Set the region name within 256 characters.

4) [Prefecture/State name] Set the prefecture or state name within 256 characters.

5) [Country] Set the country name with the country code defined in ISO 3166-1 alpha-2.
Up to 2 one-byte alphanumeric characters can be entered.
Example) Japan: [JP]

6) [Domain] Set the domain within 16 characters.
This item is required to be set.

7) [Application URI] The application URI is displayed. *1

8) [Expiration date] Set the expiration date of the client certificate.
• [1 hour]
• [1 day]
• [1 week]
• [1 month]
• [1 year]
• [2 year]
• [3 year]
• [4 year]
• [5 year]
• [10 year]
• [20 year]

9) [Strength of RSA key] Set the strength of the RSA key.*2

Set this item according to the setting of the OPC UA server side to be connected.
This item is required to be set.
• [1024bits]
• [2048bits]
• [3072bits]
• [4096bits]

1)
2)
3)
4)
5)
6)
7)
8)
9)

10)
12)11)
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*1 The application URI is used as the identifier to distinguish the OPC UA clients.
*2 The RSA key is a key pair of public key and encryption key used in the public-key cryptosystems.

Exporting the client certificate
The following shows the procedure to export the client certificate.

1. In the main window, select [Client Certificate] → [Copy] from the menu to display the [Export Client Certificate] dialog.

2. Set the save destination, file type, and file name, and click the [Save] button to export the client certificate (*.der) to the 
specified destination.

10) [Signature algorithm] Set the signature algorithm.
Set this item according to the setting of the OPC UA server side to be connected.
This item is required to be set.
• [Sha1]
• [Sha256]

11) [OK] button Create the client certificate and security key and close the dialog.

12) [Cancel] button Discard the setting and close the dialog.

No. Item Description
4  OPERATING PROCEDURE
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4.4 Acquiring and Exporting Tag Information
Acquire the tag information from the OPC UA server and export it as the tag information file (*.gtuc).
By importing the tag information file (*.gtuc) to GT Designer3, the OPC UA tag can be used in the device setting.
The following shows how to export the tag information file (*.gtuc).

1. Acquire the tag information from the OPC UA server.
Page 24 Acquiring the tag information

2. Export the tag information acquired from the OPC UA server as the tag information file (*.gtuc).
Page 25 Exporting the tag information

Acquiring the tag information
The following shows the procedure to acquire the tag information with GT OPC UA Client.

1. When the OPC UA server and GT OPC UA Client are not connected, connect them in the [Access destination device 
setting] dialog.

Page 16 Connecting with the OPC UA Server

2. In the main window, select [Tag] → [Import Tags] from the menu to acquire the tag information from the OPC UA server.

Main window

No. Item Description
1) Server name Displays the name of the OPC UA server to be accessed.

2) Tag information tree Displays the tag information acquired from the OPC UA server in a tree form.
When a folder is selected, the OPC UA tag in the folder is displayed in the tag list.

3) Tag list Displays the OPC UA tag acquired from the OPC UA server in a list.

4) [Tag Name] Displays the OPC UA tag name acquired from the OPC UA server.

1)

2)

8)

4) 5) 6) 7)

3)
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Exporting the tag information
The following shows how to export the tag information.

1. In the main window, select [Tag] → [Export Tags] from the menu to display the [Export Tags] dialog.

2. Set the save destination, file type, and file name, and click the [Save] button to export the tag information file (*.gtuc) to 
the specified destination.

5) [Data Type] Displays the data type of the acquired OPC UA tag.
• [Boolean]: Bit
• [SByte]: Signed 8-bit integer
• [Byte]: Unsigned 8-bit integer
• [Int16]: Signed 16-bit integer
• [UInt16]: Unsigned 16-bit integer
• [Int32]: Signed 32-bit integer
• [UInt32]: Unsigned 32-bit integer
• [Int64]: Signed 64-bit integer
• [UInt64]: Unsigned 64-bit integer
• [Float]: Single-precision real number
• [Double]: Double-precision real number
• [String]: Character strings
• [---]: Data type not supported by GT Designer3

Some of the displayed OPC UA tags cannot be used in GT Designer3.
For the OPC UA tags that can be used in GT Designer3, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

6) [Access Direction] Displays the access permission of the acquired OPC UA tag.
• [Read]: Allow only reading
• [Write]: Allow only writing
• [Read, Write]: Allow reading and writing

7) [Comment] Displays the comment of the acquired OPC UA tag.

8) Status bar Displays the current status.

No. Item Description
4  OPERATING PROCEDURE
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5 STARTING ASSOCIATING WITH GT Designer3
If GT Designer3 and GT OPC UA Client are installed in the same personal computer, startup GT OPC UA Client from GT 
Designer3 to import the tag information.
When GT OPC UA Client is started from GT Designer3, export the tag information file (*.gtuc), and import it to GT Designer3 
with the following procedure.

1. Acquire the server name of the OPC UA server to be connected in the [Access destination device setting] dialog.
Page 16 Connecting with the OPC UA Server

2. GT OPC UA Client and the OPC UA server to be connected mutually authenticate the certificate as necessary.
Page 21 Authenticating the server certificate in GT OPC UA Client
Page 21 Authenticating the client certificate in OPC UA server

3. In the main window, acquire the tag information from the OPC UA server.
Page 24 Acquiring the tag information

4. Export the tag information file (*.gtuc).
Page 25 Exporting the tag information

5. When the tag information file is exported, the following dialog is displayed.
Click the [OK] button to send the save destination path of the tag information file (*.gtuc) to GT Designer3 and exit GT OPC 
UA Client.

6. Import the tag information file with GT Designer3.
For the details of the operation method, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual
5  STARTING ASSOCIATING WITH GT Designer3
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6 EXPORTING CLIENT CERTIFICATE FOR GT 
SoftGOT2000

The client certificate is required to connect GT SoftGOT2000 with the OPC UA server.
When GT SoftGOT2000 is connected with the OPC UA server, the client certificate created in GT OPC UA Client can be 
used.
The following describes the procedure to export the client certificate for GT SoftGOT2000.

1. Select [Client Certificate] → [Export for GT SoftGOT] from the menu in the main window to open the [Export Client 
Certificate for GT SoftGOT2000] dialog.

2. Set the save destination, file type, and file name, and click the [Save] button to export the client certificate for GT 
SoftGOT2000 (*.gtcl) to the specified destination.

3. Import the client certificate (*.gtcl) in the [Communication Setup] dialog of GT SoftGOT2000.
For the details of the [Communication Setup] dialog of GT SoftGOT2000, refer to the following.
GT SoftGOT2000 Version1 Operating Manual
6  EXPORTING CLIENT CERTIFICATE FOR GT SoftGOT2000
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7 SWITCHING DISPLAY LANGUAGE
The display language can be switched in GT OPC UA Client.
The compatible languages are Japanese, English, and Simplified Chinese.

1. In the main window, select [View] → [Switch Display Language] from the menu to display the [Switch Display Language] 
dialog.

2. Select the language and click the [OK] button to switch the display language.

7.1 [Display Language] Dialog

No. Item Description
1) [Display Language] Select a display language.

• [English]
• [Japanese(日本語)]
• [Chinese Simplified(简体中文)]

2) [OK] button Switch the display language and close the dialog.

3) [Cancel] button Discard the setting and close the dialog.

1)

2)
3)
7  SWITCHING DISPLAY LANGUAGE
7.1  [Display Language] Dialog
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8 PRECAUTIONS

Updating the tag information
The tag information is not collected periodically by GT OPC UA Client.
When the tag information is updated, added, or deleted in the OPC UA server, acquire the tag information with GT OPC UA 
Client again to update the tag information of GT Designer3.

Precautions for drawing
For the precautions for using OPC UA tag with GT Designer3, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual
8  PRECAUTIONS
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9 TROUBLESHOOTING

9.1 Troubleshooting
When the functions of GT OPC UA Client do not operate properly, check the following items that correspond and perform 
troubleshooting.

Troubleshooting for data collection

Cannot connect to the OPC UA server

Troubleshooting for screen display

Screen display is distorted

*1 Check the version of Windows with the following procedures.
(1) Press the Windows key and [R], or from the Windows start menu, select [Windows System] → [Run].
(2) Enter "winver" in the [Run] screen.
(3) Check the version in the displayed screen.

*2 Since the screen display is expanded, it is blurred.
The following shows the setting value of [Change the size of text, apps, and other items] and the recommended display resolutions for 
each setting value of Windows 10.
Setting value: 100%, Display resolution 1024 × 768 dots or higher
Setting value: 125%, Display resolution 1900 × 1200 dots or higher
Setting value: 150%, Display resolution 1900 × 1200 dots or higher
Setting value: 175%, Display resolution 2880 × 1620 dots or higher
Setting value: 200%, Display resolution 2880 × 1620 dots or higher
Setting value: 225%, Display resolution 3840 × 2160 dots or higher
Setting value: 250%, Display resolution 3840 × 2160 dots or higher

*3 GtOpcUaClientTool.exe is stored in the folder where GT OPC UA Client Setting Tool is installed.
The following shows an example of storing location.
Example) When the install destination folder is set as default
C:\Program Files\MELSOFT\GTOPCUAClient

Checking point Corrective action
Is the client certificate trusted by the OPC UA server side? Authenticate the client certificate as a trusted certificate in the OPC UA server side.

For the details, refer to the following.
Page 21 Authenticating the client certificate in OPC UA server

Is an old client certificate with the same name stored? Delete the expired client certificate and create a new client certificate.
The client certificate is saved in the following folder.
C:\Users\(User name)\AppData\Roaming\MELSOFT GT OPC UA Client Setting 
Tool\PKI\certs
File name: GTOPCUA.der
For the details, refer to the following.
Page 22 Creating the client certificate

Is the client certificate expired?

Is the host name of the end point URL same as the server? Check the host name of the server certificate.
The server certificate is saved in the following folder.
C:\Users\(User name)\AppData\Roaming\MELSOFT GT OPC UA Client Setting 
Tool\PKI\trusted

Does the OPC UA server exist in the same host or subnet? Check the configuration of the controller.

Is the firewall setting correct? Check the firewall setting of the personal computer.

Checking point Corrective action
Is [Change the size of text, apps, and other items] set to other than 
100% in the Windows setting?

• Set [Change the size of text, apps, and other items] to 100%.
• For Windows 10 (Version 1703 or later), the screen display can be expanded to a 

higher DPI scale with the function of Windows 10. *1*2

(1) Select GtOpcUaClientTool.exe, and then select [Properties] from the right-click context 
menu. *3

(2) Select [Override high DPI scaling behavior. Scaling performed by:] in the 
[Compatibility] tab, and select [System] from the pull-down menu. 
(3) Click the [OK] button.
9  TROUBLESHOOTING
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9.2 Error Message List
The following shows the error messages that may appear when GT OPC UA Client is used.

Error message Cause Corrective action
Failed to acquire a server certificate.
The security policy and the security mode 
may not be matched with those of the server.

The security policy and security mode on the 
server side do not match with those of GT 
OPC UA Client.

Adjust the security policy and security mode to the same 
settings as those of the OPC UA server to be connected.
Depending on the OPC UA server to be connected, multiple 
security policies and security modes can be set. Check the 
specifications of the server.
Page 17 [Access destination device setting] dialog

Access is denied from the server.
Please check user name and password.
If it is an anonymous user, please make sure 
that it is set to be accessible by anonymous 
user on the server side.

• The user name or password is not correct.
• The anonymous user is selected for the 

server that does not allow access from the 
anonymous users.

Please check the user name and password.
Page 17 [Access destination device setting] dialog

Access is denied from the server.
The client certificate may not be trusted by 
the server.

The client certificate is not trusted by the 
server.

Authenticate the client certificate as a trusted certificate in the 
OPC UA server side.

Failed to connect to the server.
Please check the following settings.
• Host name of end point URL
• Server setting
• Communication environment

The connection to the server has failed. • Check the setting of the OPC UA server to be connected.
• Check the following troubleshooting.
Page 34 Cannot connect to the OPC UA server
• After uninstalling the application, install it again.
• When the same error occurs again, contact your local sales 

office.

The server has reached its maximum number 
of sessions.
Please check the number of sessions 
connected to the server.

The number of sessions on the server side 
exceeds the maximum value.

Please check the number of sessions connected to the 
server.

Failed to connect to the server.
Please wait a while and try access again.

The server side is busy. Wait a moment and then execute it again.

[Save Folder Path]
The client certificate cannot be created in this 
folder.
Please check an access permission.

There is no access permission to the save 
destination of the client certificate.

Contact the administrator and obtain the access permission.

[Save Folder Path]
The server certificate cannot be saved in this 
folder.
Please check an access permission.

There is no access permission to the save 
destination of the server certificate.

Contact the administrator and obtain the access permission.

[File name] cannot be saved in the specified 
path.
Possible causes are shown below.
• The folder path does not exist.
• The route drive is specified.
• The destination is read only.
• Other user is editing the destination.
• Memory required for save is insufficient.
• Medium of the specified drive is broken.
• The specified file name is too long.
• Other errors occurred during the saving 

process.
Save the project in another drive once.

The access destination device setting cannot 
be saved due to disconnection of network or 
other causes.

Take the following measures according to the cause.
• Check the network environment.
• Check the save destination path.
• Specify a folder as the save destination.
• Check that the save destination is not being edited.
• Reserve enough free space to store the file.
• Check that the medium of the drive to be saved is not 

broken.
• Review the name of the file to be saved.

Failed to retrieve the file.
Possible causes are shown below.
• Free space of the media where the access 

destination device setting being saved is 
insufficient.

• File data is broken.
• The access destination device setting file 

does not exist in the specified path.

• Free space of the media where the setting 
file (*.gtpm) being saved is insufficient.

• The setting file data (*.gtpm) is broken.
• The specified path of the setting file 

(*.gtpm) is not correct.

• Reserve sufficient free space in the media where the 
access destination device setting file is saved.

• Create the setting file (*.gtpm) again.
Page 19 Saving the access destination device setting to 
a file
• Specify the path where the file to be read is stored.

There is a possibility that the environment of 
the application is broken.
Please install it again.

The registry is in one of the following states.
• Registry does not exist
• Reading has failed
• An invalid value is set in the registry

After uninstalling the application, install it again.
Page 12 INSTALLATION AND UNINSTALLATION
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Failed to start tool with the display language 
specified at the time of previous termination.
Tool will be started with the default language.

• The tool failed to start with the language 
specified at the time of previous 
termination.

• Reading the file that contains the display 
item names has failed when the [Switch 
Display Language] dialog is displayed.

• Configure the settings of the [Switch Display Language] 
dialog and execute the tool again.

• After uninstalling the application, install it again.

The help file cannot be found.
Please install GT OPC UA Client.

The help file (PDF) does not exist. Install GT OPC UA Client again and execute it.
Page 12 INSTALLATION AND UNINSTALLATION

Failed to load client certificate.
Please create the client certificate again.

Loading the client certificate has failed. Please create the client certificate again.
Page 22 Creating the client certificate

Access is denied from the server.
The client certificate is expired.
Please create the client certificate again.

The client certificate is expired. Please create the client certificate again.
Page 22 Creating the client certificate

Failed to get tag informations.
Please check the server setting.

The acquired tag information (NodeID, 
DisplayName, DataType, and AccessLevel) is 
incomplete.

Check the setting of the OPC UA server side.

Failed to export tag informations.
Please export it again.

Exporting the tag information has failed. Export the tag information again.
Page 24 Acquiring and Exporting Tag Information

An unexpected error occurred. An unexpected error has occurred. • Check the setting of the OPC UA server to be connected.
• Check the following troubleshooting.
Page 34 Cannot connect to the OPC UA server
• After uninstalling the application, install it again.
• When the same error occurs again, contact your local sales 

office.

Error message Cause Corrective action
9  TROUBLESHOOTING
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10 APPENDICES

10.1 Open Source Software
This software consists of multiple software components. Each copyright of the software component belongs to Mitsubishi 
Electric or third parties.
This software includes the following open source software.
 • Software with copyright of third party and distributed as a free software
For the software with copyrights that belong to Mitsubishi Electric or third parties, the source code is not distributed.
Please refrain from asking information on the source code of open source.

Software information
The open source software included in this product is as follows.
 • RapidJSON
Page 37 RapidJSON
 • BouncyCastle
Page 38 BouncyCastle
 • OpenSSL toolkit
Page 38 OpenSSL toolkit

RapidJSON
RapidJSON, which is the MIT license, is used in this product.
The following describes the copyright notice and agreement notice of RapidJSON.
Tencent is pleased to support the open source community by making RapidJSON available.

Copyright (C) 2015 THL A29 Limited, a Tencent company, and Milo Yip. All rights reserved.
If you have downloaded a copy of the RapidJSON binary from Tencent, please note that the RapidJSON binary is licensed under the MIT License.
If you have downloaded a copy of the RapidJSON source code from Tencent, please note that RapidJSON source code is licensed under the MIT License, 
except for the third-party components listed below which are subject to different license terms. Your integration of RapidJSON into your own projects may 
require compliance with the MIT License, as well as the other licenses applicable to the third-party components included within RapidJSON. To avoid the 
problematic JSON license in your own projects, it's sufficient to exclude the bin/jsonchecker/ directory, as it's the only code under the JSON license.
A copy of the MIT License is included in this file.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the 
Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, 
and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR 
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
10  APPENDICES
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BouncyCastle
BouncyCastle, which is the MIT license, is used in this product.
The following describes the copyright notice and agreement notice of BouncyCastle.

OpenSSL toolkit
OpenSSL toolkit, which is OpenSSL License and Original SSLeay License, is used in this product.
The following describes the agreement notice of OpenSSL License and Original SSLeay License.

Copyright (c) 2000 - 2017 The Legion of the Bouncy Castle Inc. (http://www.bouncycastle.org)

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the 
Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, 
and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR 
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

LICENSE ISSUES
==============

The OpenSSL toolkit stays under a double license, i.e. both the conditions of
the OpenSSL License and the original SSLeay license apply to the toolkit.
See below for the actual license texts.

OpenSSL License
---------------

/* ====================================================================
* Copyright (c) 1998-2018 The OpenSSL Project. All rights reserved.
*
* Redistribution and use in source and binary forms, with or without
* modification, are permitted provided that the following conditions
* are met:
*
* 1. Redistributions of source code must retain the above copyright
* notice, this list of conditions and the following disclaimer.
*
* 2. Redistributions in binary form must reproduce the above copyright
* notice, this list of conditions and the following disclaimer in
* the documentation and/or other materials provided with the
* distribution.
*
* 3. All advertising materials mentioning features or use of this
* software must display the following acknowledgment:
* "This product includes software developed by the OpenSSL Project
* for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
*
* 4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
* endorse or promote products derived from this software without
* prior written permission. For written permission, please contact
* openssl-core@openssl.org.
*
* 5. Products derived from this software may not be called "OpenSSL"
* nor may "OpenSSL" appear in their names without prior written
* permission of the OpenSSL Project.
*
* 6. Redistributions of any form whatsoever must retain the following
* acknowledgment:
* "This product includes software developed by the OpenSSL Project
10  APPENDICES
10.1  Open Source Software



10
* for use in the OpenSSL Toolkit (http://www.openssl.org/)"
*
* THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
* EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
* PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
* ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
* SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
* NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
* LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
* STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
* OF THE POSSIBILITY OF SUCH DAMAGE.
* ====================================================================
*
* This product includes cryptographic software written by Eric Young
* (eay@cryptsoft.com). This product includes software written by Tim
* Hudson (tjh@cryptsoft.com).
*
*/

Original SSLeay License
-----------------------

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
* All rights reserved.
*
* This package is an SSL implementation written
* by Eric Young (eay@cryptsoft.com).
* The implementation was written so as to conform with Netscapes SSL.
*
* This library is free for commercial and non-commercial use as long as
* the following conditions are aheared to. The following conditions
* apply to all code found in this distribution, be it the RC4, RSA,
* lhash, DES, etc., code; not just the SSL code. The SSL documentation
* included with this distribution is covered by the same copyright terms
* except that the holder is Tim Hudson (tjh@cryptsoft.com).
*
* Copyright remains Eric Young's, and as such any Copyright notices in
* the code are not to be removed.
* If this package is used in a product, Eric Young should be given attribution
* as the author of the parts of the library used.
* This can be in the form of a textual message at program startup or
* in documentation (online or textual) provided with the package.
*
* Redistribution and use in source and binary forms, with or without
* modification, are permitted provided that the following conditions
* are met:
* 1. Redistributions of source code must retain the copyright
* notice, this list of conditions and the following disclaimer.
* 2. Redistributions in binary form must reproduce the above copyright
* notice, this list of conditions and the following disclaimer in the
* documentation and/or other materials provided with the distribution.
* 3. All advertising materials mentioning features or use of this software
* must display the following acknowledgement:
* "This product includes cryptographic software written by
* Eric Young (eay@cryptsoft.com)"
* The word 'cryptographic' can be left out if the rouines from the library
* being used are not cryptographic related :-).
* 4. If you include any Windows specific code (or a derivative thereof) from
* the apps directory (application code) you must include an acknowledgement:
* "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"
10  APPENDICES
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*
* THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
* ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
* SUCH DAMAGE.
*
* The licence and distribution terms for any publically available version or
* derivative of this code cannot be changed. i.e. this code cannot simply be
* copied and put under another distribution licence
* [including the GNU Public Licence.]
*/
10  APPENDICES
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* The manual number is given on the bottom left of the back cover.

©2019 MITSUBISHI ELECTRIC CORPORATION

Print date * Manual No. Revisions
April 2019 SH(NA)-082174ENG-A First edition

This manual confers no industrial property rights or any rights of any other kind, nor does it confer any patent licenses. Mitsubishi Electric Corporation cannot 
be held responsible for any problems involving industrial property rights which may occur as a result of using the contents noted in this manual.
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TRADEMARKS

SH(NA)-082174ENG-A

MELDAS, MELSEC, iQ Platform, MELSOFT, GOT, CC-Link, CC-Link/LT, and CC-Link IE are trademarks or registered trademarks of Mitsubishi Electric 
Corporation in Japan and other countries.
Microsoft, Windows, Windows Vista, Windows NT, Windows Server, SQL Server, Visual C++, Visual C#, Visual Basic, Excel, and Access are trademarks or 
registered trademarks of Microsoft Corporation in the United States and other countries.
Ethernet is a registered trademark of Xerox Corporation in the United States.
Adobe and Adobe Reader are registered trademarks of Adobe Systems Incorporated.
Intel and Intel Core are trademarks or registered trademarks of Intel Corporation in the United States and other countries.
Other company and product names herein are trademarks or registered trademarks of their respective owners.

"OPC UA Services for WPF" is used in this product.
.NET based OPC UA Client SDK(binary)
(c)2006-2019 Unified Automation GmbH. All rights reserved





SH(NA)-082174ENG-A(1904)MEE
MODEL: GT-OPC-UA-CL-0-E

Specifications subject to change without notice.

HEAD OFFICE : TOKYO BUILDING, 2-7-3 MARUNOUCHI, CHIYODA-KU, TOKYO 100-8310, JAPAN
NAGOYA WORKS : 1-14 , YADA-MINAMI 5-CHOME , HIGASHI-KU, NAGOYA , JAPAN


	SAFETY PRECAUTIONS
	PRECAUTIONS FOR USE
	CONTENTS
	RELEVANT MANUAL
	ABBREVIATION AND GENERIC TERM
	TERM LIST
	1 INTRODUCTION
	1.1 Features

	2 SPECIFICATIONS
	2.1 Operating Environment
	2.2 System Configuration
	2.3 Required Software
	2.4 OPC UA Server
	2.5 Tag Information

	3 INSTALLATION AND UNINSTALLATION
	3.1 Installation
	3.2 Uninstallation

	4 OPERATING PROCEDURE
	4.1 Starting and Exiting the Application
	Starting GT OPC UA Client
	Exiting GT OPC UA Client

	4.2 Connecting with the OPC UA Server
	Connecting GT OPC UA Client with the OPC UA server
	Saving the access destination device setting to a file
	Opening the access destination device setting from the file

	4.3 Mutual Authentication of Client Certificate and Server Certificate
	Authenticating the server certificate in GT OPC UA Client
	Authenticating the client certificate in OPC UA server
	Creating the client certificate
	Exporting the client certificate

	4.4 Acquiring and Exporting Tag Information
	Acquiring the tag information
	Exporting the tag information


	5 STARTING ASSOCIATING WITH GT Designer3
	6 EXPORTING CLIENT CERTIFICATE FOR GT SoftGOT2000
	7 SWITCHING DISPLAY LANGUAGE
	7.1 [Display Language] Dialog

	8 PRECAUTIONS
	9 TROUBLESHOOTING
	9.1 Troubleshooting
	Troubleshooting for data collection
	Troubleshooting for screen display

	9.2 Error Message List

	10 APPENDICES
	10.1 Open Source Software
	Software information


	REVISIONS
	TRADEMARKS

